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 File Menu

The File Menu contains various options that allow you to specify how Salvation handles 
files that are selected in the main scroll list.    Normally, the "Auto Mode" setting is all you 
need. This mode allows Salvation to decide what to do with a selected file. This includes 
displaying graphics files, Text Editing text files, running application files, etc.    If you want 
more control over how files will be acted upon, you can choose one of the other operating 
modes. You can always tell which mode you're in by either looking at the Salvation Title 
bar or the text located in the Default Button to the right of the scroll list. 

 Auto Mode Auto Mode is the default setting that is always selected when you start 
Windows. In this mode, Salvation determines what to do with a selected file based on its 
extension. Most users will leave Salvation in Auto Mode all the time. If Salvation cannot 
determine what to do with the file, it follows the instructions set in the Auto Mode Default 
dialog.

 Launch Mode In this mode, Salvation will run or launch any file selected. If the Show 
All Checkbox is set, files that are not applications (cannot be launched) will be shown in 
"dimmed" or grey text in the main scroll list.

 File Info Selecting a file for Info displays detailed information about the files' attributes.
You then have the option of making changes to the file. You should fully understand what file
attributes do before arbitrarily changing them.

 Rename Mode Allows you to rename a file or folder. Once selected, the filename 
appears highlighted (a period (.) character is used to separate the file's name from its 
extension). Enter the new filename then press the Enter key, or click the Rename button. If 
you want to cancel with no changes, depress the ESC key.

In order to select a Folder for renaming, hold down the ALT key while 
selecting it. This tells Salvation you want to perform the action on the Folder 
rather than opening it.

 Delete Mode This mode allows you to delete one or more files. To warn you while 
you're in this mode, all of the text in the main scroll list is shown in a red. Select one or more
files and/or folders to delete them.

If you choose a folder for deletion, all of the files within that folder as well as 
the folder itself will be deleted. This holds true for any additional folders 
found within the folder. This powerful (and dangerous) mode should be used 
with great caution.

 View Graphics Allows you to display a selected graphics file. A copy of the graphic is 
transferred to the Windows Clipboard. You can then "paste" the graphic into any Windows 
application that supports Clipboard graphics.

 Text Mode When in Text Mode, allows you to edit a text file. When a file is selected in the 
scroll list, the Text Editor window is displayed with the contents of the file. You can make 
changes, save under a different filename, copy selected text to the clipboard, etc. (visit the 
Text Editor Help menu for complete details on how to use the Text editor).



The Text Editor Menu also contains 5 other sub-menu's. The New Document selection 
will open an empty Text Editor window for use in creating a new file. The AUTOEXEC.BAT, 
CONFIG.SYS, WIN.INI, and SYSTEM.INI selections will open the text editor with one of these 
commonly accessed documents.

Do not make changes to AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, or SYSTEM.INI
unless you fully understand the impact of the change. Doing so can cause the
system to fail on boot during the next power-on sequence. Also, most 
Windows applications (including Salvation) will not respond to WIN.INI 
changes until Windows is restarted.

In addition to the operating mode selections, the File Menu provides a few other 
functions:

Printer Setup Allows the selection of a printer for Salvation printing 
operations. By default, Salvation will use the printer 
selected in the Control Panel. If you want to specify a 
different printer, use this menu item. Any changes you 
make will not affect the control panel setting or other 
applications.

Print Prints a copy of the folder or directory contents currently 
being displayed in the scroll list. The printed copy 
contains all the details concerning each file, regardless 
of the current size or viewing portion of the main scroll 
list.

ShutDown Terminates your Windows session and returns you to 
DOS.



 Edit Menu

The Edit Menu is used to manipulate buttons. Before you can use the Edit Menu,    you 
need to program some buttons using the Button Programming dialog. Once programmed, 
buttons can be transferred to clipboard, copied, moved, deleted, or transferred to other 
button pages.

Button are selected for editing by double-clicking a button's Title area. The button will
then highlight to show that it is selected. Edit functions may then be used, which 
affect only the selected button. To move or copy a button a different page, highlight 
the button, select Copy or Cut from the Edit Menu item, then change to the desired 
page. Now highlight the destination button on the new page and select Paste.

To move buttons around on the same page, you can use the Edit Menu or this faster 
method: Click and hold the left mouse button down on the Title area. Drag the mouse
(and the attached outline of the button) over the new location and release the 
mouse. The two buttons on the page will be exchanged.

 The Edit Menu functions performs the following:

Undo Cancels the last Cut, Paste, or Clear operation. Restores the edited 
button to its previous state.

Cut Transfers the data of the selected button to the clipboard, and 
clears the button. In other words, performs both a Copy and a Clear
in one step.

Copy Puts a copy of the selected button on the clipboard.

Paste Copies the contents of the clipboard to the selected button. The 
clipboard contents remain intact, so that subsequent Paste 
operations can be used to make additional copies of the button.

Clear Clears or erases a button. The contents of the button are not 
transferred to the clipboard.

You cannot transfer button data on the clipboard to other applications. Button
data is in a special format recognized only by Salvation. 



Utilities
The Utilities Menu provides high-level functions for file, disk, and button 
maintenance. Each major Utility is covered in more detail in its own section by 
choosing File Utilities, Disk Utilities, Find File, or Programming Buttons. As an 
overview, the Utilities Menu provides the following functions:

File Utilities Displays the File Utilities window, providing various 
functions used to manipulate files on disk.

Disk Utilities Displays the Disk Utilities window, providing format, 
erase, duplicate, and verify routines for floppy disks.

Find File Displays the Find File window, providing a way to search 
disks for specific files or file sets. Once found, you can 
launch, delete, or perform other operations on files. 
Enter specific Wild Cards to specify how you want the 
search to proceed. Select a disk, then click the START 
button. If you want to cancel the search prematurely, 
press the escape key.

Recover Deleted Files Displays a dialog and allows for the recovery of deleted 
files. Only files deleted within Salvation and with the 
Deferred Delete option enabled can be recovered. You 
can individually recover files by highlighting them and 
clicking the RECOVER button (or double-click the 
selection).RECOVER ALL will select all the deleted files 
and recover them. Alternatively, clicking DELETE, or 
DELETE ALL, will permanently delete the files from the 
disk. Once a file is permanently deleted, it can no longer 
be recovered.

Program a Button Displays the Programming Buttons window, which is 
used to customize a button to launch a specific program 
or file.

Edit Button Pages Displays a dialog that allows manipulation of entire 
Button Pages. You can Add, Delete, Move, Copy or Swap 
button pages by clicking on the appropriate button. Use 
Swap to re-arrange the page ordering to place your most
frequently used button pages at the top of the list.



Scroll List Functions
The Scroll List Menu items are options that are specifically related to the way files are 
displayed and handled in the Main Scroll List. These options perform the following:

Full Size/Normal Size This option stretches or shrinks the main scroll list to 
show extended information about each file. Once 
expanded, selecting the menu again will shrink the list 
back to normal size.    You may also click and hold down 
the mouse button on the left side of the scroll list and 
drag the list to any size desired. The menu name of this 
function changes between FULL and NORMAL when the 
scroll list is resized.

 File Sort This menu item contains five sub-menus that will change the sorting order of 
files in the list. You can sort files by name, extension, ascending size, ascending date, or 
attributes. Note that this selection only changes the way files are viewed, and does not 
physically rearrange files on the disk.    

 Folder Sort This option allows you to separate the viewing order of folders and files in the 
list. The Normal selection displays all files/folders alphabetically by name. The Top of The List
selection groups and sorts all folders alphabetically first, followed by files. Note that this 
selection only changes the way folders are viewed, and does not physically rearrange folders
on the disk. 

 Specify Wild CardsAllows you to enter Wild Cards to limit or screen the types of files 
displayed in the main scroll list. The Wild Card Dialog is shown, where you can enter your 
screen parameters. The Reset button resets all fields, while the Inverse checkbox shows you 
the inverse of your screen. That is, all files EXCEPT those that match the Wild Card 
parameters. As a short cut, you can also change or reset Wild Card parameters by clicking in
the Status Panel.

Auto Mode Default Displays a dialog that defines the actions Salvation 
should take if it cannot determine what to do with a file 
selected in Auto Mode. See Auto Mode Default for more 
information.

 
 Show Invisible Files Selecting this option allows files that have their Invisible 

attribute set to be included in the scroll list. If the Status Panel indicator is shown in RED, 
you are warned that any Invisible files in the current folder are being hidden from view.

 
 Show System FilesSelecting this option allows files that have their System attribute set to

be displayed in the scroll lists. If the Status Panel indicator is shown in RED, you are being 
warned that any System files in the current folder are being hidden from view.

 All Upper Case Selecting this option shows all filenames in upper case characters. 
When deselected, files will be shown in lower case characters with the filename and 
extension capitalized.



Setup Menu
The Setup Menu lets you change the overall operating characteristics of Salvation. Note 
that all of the settings in this menu are ones of personal preference; there are no "right" 
or "wrong" settings. We recommend you try each option to determine which settings are 
best for you.

 
 Advanced User Checking this option causes many of Salvation's confirmation and 

warning dialogs to be suppressed (for example, you will not be prompted again after 
selecting a file to delete with a "Are you sure you want to delete?" message).    We 
recommend that you check this option only after you have become familiar with Salvation. If
the Advanced User Status Panel icon is shown in RED, this is to warn you that Advanced User
mode is turned on.

 Deferred Delete Checking this option turns on Salvation's Deferred Deletemode. 
Deferred Delete gives you a "second chance" in recovering files that have been accidentally 
deleted. You can then use the Recover Deleted Files selection in the Utilities menu to recover
one or more deleted files. When Deferred Delete is checked with one or more files deleted 
and you try to exit Windows, Salvation always    prompts you to re-confirm all deletions 
made. If the Delete icon in the Status Panel is shown in RED, this is to warn you that real 
deletes will occur, as Defer Delete has been turned off.

 Remember Last Page When Salvation is started, the main, or first, button page is 
always displayed. When this option is checked, Salvation    remembers the last button page 
used, and displays that page instead. This setting only affects the initial page display shown 
when you start Salvation. 

 Force Root on Drive Change Salvation always remembers the last pathname 
displayed for every drive connected to the system. When you change drives, the initial scroll
list display is set to the last pathname used for that drive. Checking this option forces the 
root directory to be displayed instead of the remembered pathname.

 Show Hot Keys When checked, this option displays the keypress equivalents that can 
be used to activate the launch button. Note that this is a display option only- the keypresses,
or "Hot Keys", can be used at any time whether or not the Show Hot Keys option is checked. 
In other words, it simply shows you the keypresses to use.

 Park Heads on ShutDown Using this option allows you to park the heads of your hard 
drive and to safely power down the system while in Windows. (You should check the manual 
that came with your computer or hard drive to see if parking is necessary). When Park Heads
on ShutDown is checked, you will not return to DOS when shutting down from Salvation. 
Instead, a dialog will be displayed (after the heads are parked) at which point you can power
down the computer. If you click the OK button, you will return to DOS and the heads will no 
longer be parked.

DO NOT TURN YOUR COMPUTER OFF WHILE IN WINDOWS.
Some Windows programs may have "open" files that can become damaged 
at an unscheduled power-down. Similarly, many programs save configuration 
information (including Salvation) at ShutDown time. Never power down the 
system while in Windows unless the Park Heads dialog is being displayed. It is



also a good idea to close all other Windows applications before clicking 
Salvation's ShutDown button, just as an added measure of safety.

 Program Mgr Emulation Many Windows-based "Install" or "Setup" type programs that 
come with applications create Program Manager Groups and icons during the installation 
process. When this option is checked, Salvation will "emulate" or act like the Program 
Manager, interacting with these setup programs to create new button pages and buttons 
automatically. 

Program Manager Emulation should not be checked if both Salvation and the 
Program Manager are running at the same time. Although this will cause no damage 
to the system or files, it could prevent button pages and/or buttons from being 
installed. As a general rule of thumb, check this option before running Setup type 
programs, then uncheck it afterwards.

 Editor: Keep a BAK File This option affects the Text Editor. If checked, any time you save
a file back to disk, the previous version of the file will not be overwritten. It will be renamed 
with the extension of ".BAK". Note that you may subsequently defeat this option from the 
Text Editor's Options Menu on a file by file basis. If you do not use Save or Save As while in 
the Text Editor, this option has no effect.

If you edit and save a file with a .BAK extension, or you intentionally name    
your original file using an extension of .BAK, the text editor will not be able to
maintain a separate .BAK file. As a general rule, you should not use the .BAK 
extension for your    files. If you want to edit    a .BAK file, use the Save As 
command in the Text Editor to rename the file's extension    to something else
BEFORE saving it back to disk.

 Editor: Edit Any ExtensionFile Salvation determines which files are text files by looking 
at their extensions. Files with the extensions of TXT, DOC, INI, SYD SYS, and BAK are 
considered text files. Occasionally, you will encounter other text files (i.e., "READ.ME" or 
"README.") that not adhere to the above extension list. Checking this option tells Salvation 
to consider all files to be text files, regardless of their extension.

This option is valid only while in Text Mode. It has no effect while you're in Auto 
Mode. However, you can use the Auto Mode Default dialog to redirect files (with 
unrecognized extensions) to the text editor, which will produce roughly the same 
results as using this option setting. This option also overrides normal text file 
recognition and allows the editing of any files, including those that are not truly text 
files. For example, you could load a graphics image or an executable program into 
the text editor. If the text editor displays a warning dialog indicating that the file 
contains "NULL" characters, chances are it is not a text file and SHOULD NOT BE 
SAVED BACK TO DISK. Using Save or Save As on such a file will damage the file 
contents and render the file unusable.

 Editor: Monospace Mode This option starts the text editor in a mode causing the Salvo 
Modern Font to be used, which shows most control characters and non-ASCII characters in 
document.



 Editor: Word Wrap Mode This option starts the text editor in Word Wrap mode, which 
causes long lines of text to fit into the text editor window.

 Editor: Read Only This option starts the editor in Read-Only mode. This will disable the 
Save and Save As buttons, and any changes made to file cannot be saved back to disk.

The following Setup Menu Options display additional dialogs rather than simple Check
On/ Check Off type selections:

Clock Settings... This options displays a dialog box that allows you 
to change the clock display and time setting, and 
to set Salvation's Alarm clock. Note that 24-hour 
values in clock display require accurate numerical
settings (military time) when you go to set the 
alarm.

Timed Launch... This option allows you to automatically launch an 
application at a certain time or day(s) of the 
week. For example, It can be used to perform late
night backups or non-prime-time modem 
communications.

Document Launch... This option increases Salvation's knowledge of 
recognized extensions. Once programmed, 
Salvation will know what to do with the new file 
types    when selected in the main scroll list or 
programmed into buttons. See Document 
Launching for additional details. 

Screen Blanker... Displays a dialog window that allows 
programming of the screen blanker. A screen 
blanker or screen saver is used to extend the life 
of your video display by preventing static images 
from "burning"    into the glass picture tube. You 
can set the amount of time you want for the 
blanking to take place from 1 to 99 minutes. 
When no mouse or keyboard activity is detected 
for that amount of time, the screen will go black. 
A graphics image of a bicycle will occasionally be 
displayed to indicate blanking is in effect. Hit a 
key or move the mouse to restore the screen 
back to normal.

When Screen Blanking is enabled, overall system performance/speed is slightly 
degraded.



Add-on's
The Add-on's, or Extras, Menu is used to add additional functionality to Salvation. Add-
on's are additional programs or "optional equipment" that can be installed into Salvation 
at any time. An add-on program has already been included with Salvation, called Windows
Shell Switcher. When an Add-on program is properly Installed, its icon appears next to the 
add-on item in the Menu.

System Info The menu selection is the default add-on item 
(technically, it is built into Salvation and not really an 
Add-on program). This option displays a dialog with 
various items of information concerning the system and 
current Windows operating mode.

Windows Shell Switcher This add-on program allows you to change the shell or 
startup program for Windows. Normally, Salvation is the 
shell, but you can switch back and forth between 
Salvation, Micro-Launch, or the Program Manager. Simply
select the new shell and click the Restart Windows 
button in this dialog. If you use the Program Manager 
frequently, It is a good idea to create a Program Manager
Group item of this add-on program (named 
SWITCHER.EXE in your Windows folder). This way, you 
can make Salvation the shell from the Program Manager 
by running SWITCHER.EXE.

If Salvation is not designated as the Windows shell, the Head Parking option 
will not function, and the ShutDown button will not terminate your Windows 
session. Clicking ShutDown will only close Salvation's main window, just like 
any other application's Close or Exit function.

If you've installed additional add-on's, there will be other programs displayed under 
the Add-on's menu at this time. Refer to the documentation included with the 
individual add-on program for help documentation and    information.



Security    and Passwords

The Security Menu contains all items related to protecting your files from 
unauthorized users. If your computer contains sensitive information or is shared by
others who should not have access to your files, you should use these menu items 
to protect your data.

In general, you add security at the folder-level. When a folder is secured, you must 
enter a password to open the folder.    This protects all of the files in the folder. As 
you become familiar with Salvation's security system, you may want to rearrange 
your files into protected and non-protected folders Also, buttons can be password 
protected (See Button Programming for additional details).

When Salvation is first installed, the password is set to "SALVATION". It is a 
good idea to change the password after installation. If you forget your 
password, you will not be able access any secured folders. See the Salvation 
User's manual under the Security and Passwords section on how to handle 
this situation.

Password Protect This item provides a way to add password 
protection or to remove password protection from
a folder. To protect a folder, click once on the 
folder, then select this menu item. Once a folder 
is protected, it will be displayed with a small 
graphic of a padlock.    To unprotect a folder, click 
once on the protected folder and select this menu
item. You will have to enter the password to 
unprotect a folder. If the Password Protect menu 
item does not correctly identify the folder as 
protected, see the Validate Now description 
below.

Change Password This item is used to change the password. 
Passwords must consist of alpha-numeric 
characters, and be 10 or less characters in length
(passwords are case insensitive- both upper and 
lower case letters have the same meaning). You 
must enter the existing password before you can 
change it. The existing password for a newly 
installed copy of Salvation is "SALVATION".

Password Prompt at Startup If this item is checked, you will have to enter the 
correct password in order to start Windows.

Validate on Startup If this item is checked, Salvation will perform 
Validation during the start-up process. See 
Password Validation for additional details. 

Maximum Security If this item is checked, you will put Salvation in its
maximum security mode. In this mode, all of 
Salvation's utilities are disabled, and severe 
restrictions will be placed on any functions that 
allow disk access, including ShutDown. To turn off 
Maximum Security, select the menu item again 



and enter the password. This feature can be used 
when you leave your workstation for a period of 
time or    want to severely restrict access to other 
users.

Validate Now Selecting this item performs immediate password
validation. See Validation for additional details.



Programming Buttons

The Programming Buttons dialog is used to define all of the parameters necessary to 
properly set up a button. To access this dialog, double-click on a button to highlight it, 
then select the PROGRAM A BUTTON item in the Utilities Menu. You may also click once 
with the RIGHT mouse button in the button's Title Area.

In most cases, you do not have to enter any data into the fields of the 
Programming Buttons dialog. Here's how: Click the AUTOMATIC button, find the 
file you want and double-click on it, and Salvation will automatically fill in the 
appropriate fields. The Programming Buttons Dialog will then close automatically.

 The Dialog gives you many choices in specifying how you want the button to respond. 
Each of the fields and controls in the dialog are described below:

Button Title Enter the Title that you want to appear in the Title Area of the 
button. You can enter any combination of alpha-numeric or symbol 
characters. If the text entered does not fit on one line, the text will 
be word-wrapped on separate lines in the Title Area. You may also 
add extra spaces between words to force word-wrap to occur at 
certain points. The following buttons are also included:

Clear Erases the current text in the Button Title.

Upper Converts the current text in the Button Title to all upper case
characters.

Lower Converts the current text in the Button Title to all lower case 
characters.

Capitalize Capitalizes the text in the Button Title.

Program Path Enter the full pathname of the program to run. 
Optionally, you may enter any command line parameters or 
additional file pathnames that is needed by the entered program. 
Other Controls provided are:

Clear Erases the current text in the Program Path.

Find Displays a dialog that allows you to select a launchable file. 
You may also select a Document, providing its extension has been 
pre-defined using the Document Launch dialog.

PIF Editor  Brings up the PIF Editor for creation or editing of a PIF 
file. If the Program Path points to an existing PIF file when this 
button is clicked, that file will appear in the PIF editor window.    

Password Prompt on Launch    Checking this box will require the 
password to be entered whenever the button is later clicked for 
launching.



NOTE:    You can set Password Prompt for any launchable 
file, not just those located in secured folders.

Startup Path You can optionally set a different pathname than the program's 
pathname (specified in the Program Path) when you start your 
application. For example, your word processor's EXE file can be in 
one folder, while your documents can be in another. You can set 
these two pathnames to the two different locations. Note that you 
should not enter a file name (i.e., an EXE or COM file), just the 
pathname or location of the file. A trailing slash may be optionally 
used as the last character in the path. Other Controls provided are:

Clear Erases the current text in the Startup Path.

Same as Program Path Forces the Startup Pathname to the same 
location as specified in the Program Path. For most applications, 
checking this box is the normal configuration. When checked, any 
Pathname is cleared from the Startup Path,    and    both the Startup 
Path and Clear button will be invisible.

 
Icon Path You can optionally specify the source of the icon for the button. 

Normally, the icon graphic is derived from the file specified in the 
Program Path, but can come from any EXE, COM, or ICO type file.      
Other Controls provided are:

Find Works the same as the Program Path's FIND button described 
above, buts finds a file to be used for the Icon Path. Once found, a 
list of all icons located in that file is displayed. Choose one of the 
icons by selecting it and then clicking the select button. Note that 
some files may have only one icon. Others, such as DOS 
applications, do not have any icons. In this case, Salvation will 
substitute stock icons from the icon library.

Choose Displays all of the icons currently located within the file 
specified by the Icon Path. You can then select the desired icon to 
use. This button functions only while there is a valid file listed in the
Icon Path.

 
Library Displays all of the icons from Salvation's icon library. These 
are general purpose icons that you can use for any purpose.

Clear Erases the current Text in the Icon Path.

Same as Program Path Forces the Icon Path to the same location as 
specified in the Program Path. For most applications, checking this 
box is the normal configuration. When checked, any pathname is 
cleared from the Icon Path, and all controls in the Icon Path box will 
be invisible. If the application specified in the Program Path does 
not contain any icons, one will be substituted.

Minimize Salvation on Launch
Displays all of the icons from Salvation's icon library. These are 
general purpose icons that you can use for any purpose.



Prompt for Additional Parameters
Erases the current Text in the Icon Path.

Define as Page Jump
If checked, the button will act as a jump to another button page. 
The exact page name must be entered into the button title field. 
Pathname and Startup dialogs are ignored.

Automatic Forces the Icon Path to the same location as specified in the 
Program Path. For most applications, Checking this box is the 
normal configuration. When checked, any pathname is cleared from
the Icon Path,    and    all controls in the Icon Path box will be 
invisible. If the application specified in the Program Path does not 
contain any icons, one will be substituted.

OK Erases the current Text in the Icon Path.

Cancel Erases the current Text in the Icon Path.

If you frequently launch DOS programs from your buttons, or you use the 
DOS PROMPT button in the main window, see Running DOS Programs for 
additional information.

 



Auto Mode Default

While in Auto Mode, Salvation can recognize and act upon most of the commonly used 
extensions. However, due to the sheer number of file extensions and their arbitrary use, 
Salvation cannot be aware of all of them. In these cases, Salvation must be instructed 
how to handle a selected file with an unknown extension. The Auto Mode Default Dialog 
sets up the actions to take on these files. 

If you are not sure how to set this option, use either the "Generate a Beep" or "Do
Nothing" setting. This will ensure that unknown file types are left alone.

The Auto Mode Default Dialog, selected from the Scroll List Menu, contains the following 
choices:

Get Info On the Selected File
This option instructs Salvation to open an Information dialog on 
the file selected. This produces the same results as if you had 
selected the file while in Info Mode.

Pass File to the Text Editor
This option instructs Salvation to open a Text Editor window with 
the selected file. This option overrides normal text file recognition 
and allows the editing of any files, including those that are not 
truly text files. For example, the file    could be a graphics image or 
a binary database file. If the text editor displays a warning dialog 
indicating that the file contains "NULL" characters, chances are it 
is not a text file and SHOULD NOT BE SAVED BACK TO DISK. Using 
Save or Save As on such a file will damage the file contents and 
render the file unusable.

Go To Document Launch Setup
This option immediately opens the Document Launch Dialog with 
the passed extension. This dialog allows you to    add extensions 
recognized by Salvation. See Document Launch for more 
information.

Generate a Beep
This option instructs Salvation to produce an error or system beep,
indicating that the file is not recognized.

Do Nothing
Salvation does not respond to unrecognized files. Doubling clicking 
or selecting such files have no effect and produce no additional 
actions.



File Utilities Window

The File Utilities window contains all the necessary functions to manipulate files on 
your disks. You can Copy, Move, Delete, Rename, and Compare files, as well as 
create new folders and get information on    files. 

The window is organized as two scroll lists, with the "Source" scroll list on the left, 
and the "Destination" scroll list on the right. For Copy and Move operations, files 
are always transferred from left to right. Below each scroll list is an identical set of 
buttons that can be operated independently.

Because of the frequent manner in which the File Utilities window is used, there 
are several ways to open the window. You can select the File Utilities menu item in 
the Utilities Menu, click the File Utils button in the main window, or click anywhere 
on the Salvation screen with the right mouse button (Do not click over a button. 
This area is reserved for    opening the programming buttons dialog).

The File Utilities contains is own Menu as well as several buttons and controls: 

Menu Items
 
Disk Change This selection forces Salvation to re-read the disks currently 

selected in both scroll lists. It also resets the scroll lists back to the 
root directory. Use this item when changing floppies or to quickly 
return to the root directory.

Close This selection closes the File Utilities window. Same as clicking the 
DONE button or selecting close in the System Bar Menu.
    

Sort by Name This selecting sorts both lists alphabetically by filename.

Sort by Extension This selecting sorts both lists by    extension. 

Folder Sort You can sort or separate folders from files for better access and 
readability. When NORMAL is selected, folders and files are 
displayed alphabetically. When TOP OF THE LIST is selected, folders 
are grouped alphabetically at the top of the list, followed by files.

Show Invisible Selecting this option allows files that are marked as Invisible to be 
displayed in the scroll lists.

Show System Selecting this option allows files that have their System attribute 
set to be displayed in the scroll lists.

All Upper Case When selected, all files will be shown in upper case characters. 
When deselected, files will be shown in lower case characters with 
the file name and extension capitalized.

Specify Wild Cards This item opens a dialog that allows you to enter Wild Cards to 
perform additional screening of the files to be displayed.

The above option settings are set to the same settings in the main Salvation 
Window when the File Utilities window is first opened. Changing any of the 



above options does not affect the corresponding settings in the main window.

Buttons and Controls

Swap Allows you to reverse the pathnames of the source and destination 
lists, useful for Copy , Move, and Compare operations.

Set Allows you to set either the source list pathname to the destination 
list pathname or visa-versa. 

Copy Begins the copy process of copying    files from the source list to the
destination list. When Folders are encountered, all of the files 
located in all other folders and sub folders are also copied.

Move Moves files from the source pathname to the destination pathname.
Move operates much faster than Copy, but can only be used if the 
source and destination pathnames point to the same disk. Move 
has the same effect as copying a file somewhere else, then deleting
the original.

Compare Compares one or more files. A dialog will be shown reporting the 
results of the compare operation. You must select the same number
of files in the source and destination lists. Folders must be opened 
and all their files selected if you want to compare the entire 
contents of a folder.

Compare's are performed on a file-by-file basis, starting at the top of the scroll lists 
and working downward. When multiple files are selected, make sure that the files 
selected in both lists are in the same order. Otherwise, you could wind up comparing
the wrong files.

View Size Displays the size in bytes and the number of files selected in the 
scroll list. Any    folders selected will be searched for files and added
to the totals.

Copy Dates If checked, the original Date and Time of the file(s) to be copied will
be attached to the new copies. If unchecked, the current Date and 
Time will be used. This setting does not affect the backup bit, which
is always set on the newly    copied file(s).

Done Closes the File Utilities window.

Drives Changes the scroll list to show all of the local and networked drives 
attached to the system. Double-click the desired drive.

Select All Selects all the files in the scroll list. This includes those that you 
cannot see    folders containing lots of files.

If a Wild Card is set, Select All selects only those files that match the Wild Card 
parameters.

New Folder Creates an empty folder in the current pathname. A dialog will be 



shown allowing you to enter the name of the new folder.

Rename Allows renaming one or more selected files or folders. If you select 
multiple files, you have the choice of    renaming all selected file 
names or extensions in one operation.

Delete Deletes one or more files or folders. Any additional files or folders 
within a selected folder will also be deleted.

If the Advanced User option is checked, any files selected will be deleted without 
warning.

Info Displays file info on one or more selected files. Works exactly the 
same as the Info Mode selection in the main window.

During any operation (i.e., in the process of Copying, Deleting, etc.), depressing the ESC 
key will abort the operation in progress.



Disk Utilities

The Disk Utilities window allows you to Format, Erase, Verify, and Duplicate floppy 
disks. In addition, it also give you a summary of the disk space used and free on all 
drives, including hard disks.

To activate any of the buttons, select a floppy disk drive in the list. You are prevented 
from performing any of these disk operations on hard disks.

Format This selection formats the selected disk. A second dialog will appear
that lets you choose the capacity and whether or not you want to 
make the disk bootable. Formatting destroys all data on the disk. 
Depending upon the capacity, formatting could take several 
minutes.

Make sure you choose the proper capacity for the type of floppy diskette 
installed in the drive. Trying to format a low capacity diskette for high 
capacity will either fail during the Format process, or produce an unreliable 
floppy.

Erase This selection erases the selected disk. The difference between 
erase and format is that erase only clears the directory information,
freeing up the entire disk for other files. Whenever possible, you 
should Erase rather than Format since erasing    takes only a few 
seconds compared to several minutes for formatting. However,    
Erase can only be used on floppies that have been previously 
formatted or used.
    

Duplicate This selection allows you duplicate or make a copy of a diskette. 
Salvation first copies the original disk data to either memory or 
your hard disk. When you are prompted to insert the destination 
diskette, the data is copied back to the new floppy, destroying any 
previous data. If the destination disk is not formatted, Salvation will
format it automatically during the copy process, but the disk 
duplication will take considerably longer. Once done, you have the 
choice of making additional copies of the original disk, or returning 
to the Disk Utilities dialog.

Verify This selection verifies that all the data on the selected disk can be 
read. If any errors occur, Salvation will report which disk tracks 
have been found bad. You can use the CHKDSK utility to try and 
repair the disk or discard the floppy.

Re-Scan This button re-reads all of the drives and updates the scroll list. It is 
useful when changing to a different floppy.

Megabytes, KiloBytes, Bytes
These selections change the numeric capacity displays to the 
selected format.





Find File

The Find File window allows you search your disks for specific files or file sets. Once 
found, you can launch, delete, or perform other operations on these files. You enter 
specific Wild Cards on how you want to search to proceed. Select a disk to search, 
then click the START button. If you want to cancel the search prematurely, press the 
ESC key.

Reset Clicking this button reset the Wild Card parameters.

Set To Main Clicking this button transfers the pathname of the selected file to 
the main scroll list. This can be used if you want to perform other 
operations on the found file.
    

Launch This selection launches the selected file.

Text Edit This selection open the Text Editor window with the selected file.

Delete This button deletes one or more selected files.

Select All Quickly selects all the files in the scroll list. Click again to deselect 
all.

Multiple file selection is allowed in the scroll list, but only in support of the 
Delete function. If more than one file is selected when you click SET TO MAIN,
LAUNCH, or TEXT EDIT, the first file selection is used.



Deferred Delete

When the Deferred Delete option is turned on, any files that you delete are deleted, 
except copies of the file's data are kept in a special section on your disk. If you later 
choose to recover one or more files, Salvation recreates the original file be restoring 
the file's data.

In order for Deferred Delete to work, you must have a TEMP or TMP variable defined 
in your AUTOEXEC.BAT file. This is the location where Salvation saves deleted file 
data. When you exit Salvation, a dialog is displayed giving you an opportunity to 
recover these files. You may also choose the Recover Deleted Files dialog (located in 
the Utilities Menu) at any time.

Never delete any files in the TEMP folder that have the extension of DFD. 
These files contain records of your delete operations, and will prevent the 
recovery of a previously deleted file.



Validation

The VALIDATE NOW and VALIDATE ON STARTUP items in the Security menu perform 
internal clean up operations related to Salvation's security and password protection 
system. These validate selections do not change your password or alter any of your 
protected folders. 

Windows as well as DOS do not contain any password or security functions. As a 
result, Salvation must use its own unique methods. When you delete, move, or 
change the attributes of a password protected folder using a DOS or Windows-based 
utility, Salvation is unaware of these changes. The validate functions "cleans up" any 
discrepancies between changes made in the disk directories related to your 
password-protected folders.

As a general guideline, follow these rules regarding the use of the Validate functions 
in the Security Menu:

[1] If you don't have any password-protected folders, you never need to select the
VALIDATE NOW item. Likewise, the VALIDATE ON STARTUP item should be 
disabled by unchecking it.

[2] If you have only a small number of password protected folders (say, less than 
10 or 20), you should occasionally select the VALIDATE NOW item. The 
VALIDATE ON STARTUP item can be left unchecked.

[3] Regardless of how many password-protected folders you have, if you use only 
Salvation's    file utilities, you never have to use either VALIDATE NOW or 
VALIDATE ON STARTUP. 

[4] If you have a large number of password-protected folders and frequently use 
other file and disk utilities, check the VALIDATE ON STARTUP option.    
VALIDATE NOW does not have to be used.

If the above rules are not followed, no damage will be caused to either your files or 
your hard disk. The result may only be an occasional password-protected folder 
reverting back to an unprotected state. 

 



Document Launching

The Document Launch item in the Setup Menu allows you to specify "links" between 
files containing certain extensions and an application. Once these links are 
established, you can launch any file just as if it were an EXE or COM program. This 
capability is called Document Launching, since you are actually launching a 
"document" that belongs to a particular application.

Document launching is active for files selected in the main scroll list only while in 
Auto Mode, 

Once a document has been defined, Salvation knows that the document belongs to a 
particular application. If you double-click the document file in the main scroll list, the 
file is passed to its application and the application is launched. In most cases, this 
results in the application's window being displayed with the document. For example, 
the Windows Terminal program uses the extension TRM to define telephone numbers 
and communications parameters. Clicking a file called BBS.TRM would launch 
Terminal, and configure it automatically with the BBS settings. 

Once a document has been defined, you'll be able to use the FIND and AUTOMATIC 
features of the button programming dialog to select and program document buttons. 
You still retain the capability of programming any button to launch a standard EXE or 
COM file.

It is recommended that PRIVATE EXTENSION LIST be checked in the 
Document Launch Setup dialog. This causes Salvation to create and maintain 
its own list of Document Launch extensions, separate from the overall system
list. Many Windows applications will alter the system list without your 
knowledge. This can cause conflicts with both Salvation's standard list of 
extensions as well as you own customized list. For example, Word for 
Windows(tm) will register the DOC extension, conflicting with Salvation's Text 
Editor. In this case, you will not be able to use the Text Editor with files 
containing the DOC extension while in Auto Mode.



Attributes
File attributes mark files with certain characteristics:

Invisible Invisible files and folders are "hidden" and can't be seen in scroll lists.

System System files are files that are marked as special system-use files.
(A System file is not the same as a file with a SYS extension).

Backup The backup attribute is set whenever a file is created,modified, or 
copied. This tells backup programs that the file requires backing up.

Read-Only A file with its Read-Only attribute set cannot be deleted or changed.

Date/Time The Date and Time the file was created or last modified.



WildCards
Wild Cards consist of the Asterisk (*) and Question Mark (?) characters.    An 
Asterisk denotes the matching of any characters, while the question mark is used 
to mask individual characters.
For example:

*.EXE        Include all files with an EXE extension, regardless of their file name.

CA?.*       Include such files as CAP.EXE, CAT.PIF, and any others matching any 
3rd character.

*.* Includes all files, just as if Wild Cards weren't used at all.



The Status Panel

The Status Panel, located in the upper right corner of the main screen, provides a 
continuous display of the most frequently used (and changed) Salvation settings. All 
of the icons in the panel correspond to certain checkmark and checkbox settings 
located in the menus. As a general rule, an icon highlighted in red indicates a 
warning to you that you should be aware of.

In addition to simply displaying the status, you can double-click directly on an 
individual icon to change the status. The Status icons show you the following.

      Indicates a Wild Card screen is in effect.    Double-click to remove the Wild 
Card screen and to show all files. If not highlighted, double-click to bring up 
the SPECIFY WILD CARDS dialog box.    This setting follows the checkmark 
setting for WILD CARDS in the Scroll List Menu.

 
      Indicates Advanced User option is in effect.    Double-click    to set or reset. Follows the
ADVANCED USER checkmark in the Setup Menu.

      Indicates that Invisible Files are hidden from view. Double-click set or reset. Follows 
the SHOW INVISIBLE FILES checkmark in the Scroll List Menu.

      Indicates that System Files are hidden from view. Double-click to set or reset. Follows 
the SHOW SYSTEM FILES checkmark in the Scroll List Menu.

      Indicates that real or true deleting is in effect. You will not be able to recover any 
deleted files. Double-click to set or reset. Follows the Deferred Delete checkmark in the 
Setup Menu.

      Indicates the Alarm Clock is set. Double-click to turn off the alarm. If not 
highlighted, double-clicking will display the Clock Settings dialog window.



Running DOS Programs

When you launch a DOS program from one of your buttons, the main scroll list, or use
the DOS PROMPT button in the main window, Windows appears to be no longer 
running. In fact, portions of Windows are running while other portions are stored in 
memory and on disk as temporary files. 

Certain DOS commands and DOS-based programs should not be used that can 
corrupt Windows memory and/or Windows temporary files. These programs modify 
the disk structure. Examples are:

(1) The DOS CHKDSK utility using the /F option.

(2) Any utility that allows "Undeleting" of a file or recovery of deleted files or 
folders.

(3) Any utility that performs disk compression, disk optimization, or low level 
directory sorting.

To use these programs, you should exit Windows first and then run the program from 
DOS.
    



 
Title Area
The part of the button which contains theTitle. Click with the RIGHT mouse button to 
program the button. Click and hold down the LEFT mouse button to move the button to 
another location. 



Main Scroll List
Main Scroll List
To select a FILE, click on it once then press
the Enter key, or double-click on the file.    
To perform an action on a FOLDER (instead
of opening it), hold down the ALT key while
selecting.



Extensions
A file extension is a one to three character
file identifier.    Salvation "tabs" the 
extension part of a file name in all scroll 
lists for better readability.    However, when
entering a filename, you should use a 
period character to tell Salvation where 
the extension begins.



Show All Checkbox
The Show All Checkbox, located to the 
right of the main scroll list. When checked,
all files are shown, but those files that do 
not apply to the current mode are shown 
in "dimmed" or grey text. When 
Unchecked, only files that apply to the 
current mode are shown.

The Show All Checkbox has no effect while
in Auto, Info, Rename, or Delete Modes.
 



Button Page
A button Page is a set of button launchers.
Use the Pull-down Menu above the buttons
to change to a different button page. You 
can have as many button pages as you 
like.


